The Hückel Approximation

In this exercise you will use a program called “Hückel” to look at the \( \pi \) molecular orbitals in conjugated molecules. The program calculates the energies and shapes of \( \pi \) (pi) molecular orbitals using the Hückel approximation. At the end of this exercise you should hand in the answers to the questions in the EXERCISE section.

The Hückel Approximation

Consider a conjugated molecule i.e. a molecule with alternating double and single bonds, as shown in Figure 1.

![Figure 1](image1)

The Hückel approximation is used to determine the energies and shapes of the \( \pi \) molecular orbitals. In other words, the Hückel approximation assumes that the electrons in the \( \pi \) bonds “feel” an electrostatic potential due to the entire \( \sigma \) (sigma) bonding framework in the molecule (i.e. it focuses only on the formation of \( \pi \) bonds, given that the \( \sigma \) bonding framework has already been formed). Let’s look at the simplest example, ethylene \( \text{CH}_2\text{=CH}_2 \) (Figure 2).

![Figure 2](image2)

In ethylene the carbon atoms are sp\(^2\) hybridized and the sigma bonding framework consists of the sp\(^2\)-sp\(^2\) overlap between the two carbon atoms and four sp\(^2\)-s overlaps between the sp\(^2\) orbitals of the carbon atoms and the s orbitals of the hydrogen atoms. On each carbon atom is a 2p\(_y\) orbital lying perpendicular to the plane containing all the \( \sigma \) bonds (C-C and C-H \( \sigma \) bonds, see Figure 3). Each of the 2p\(_y\) orbital contains a single electron.
(Note: The orientation of two p orbitals overlapping to form a σ bond is perpendicular to that shown in figure 3. In other words, for two p orbitals to overlap and form a σ bond, the two p orbitals must lie along the inter-nuclear axis connecting the nuclei of the two atoms, as shown in figure 4. The resulting σ bond is formed along the bond axis).

The two 2p_y atomic orbitals on the carbon atoms can overlap to form π molecular orbitals. As with overlap of atomic orbitals to form σ molecular orbitals, when the two 2p_y atomic orbitals overlap two π molecular orbitals are formed. The Hückel approximation is used to determine the energies and shapes of these two π orbitals. The energy level diagram of the π molecular orbitals, as determined by the Hückel approximation, is shown in Figure 5. In this figure, the dotted line denotes the energy of the 2p_y atomic orbitals. As shown in Figure 5, one of the π molecular orbitals is lower in energy relative to the 2p_y orbitals and the other is higher in energy relative to the 2p_y orbitals.
The $\pi$ orbital lower in energy is called the $\pi$ bonding orbital (analogous to the $\sigma$ bonding orbital) and the higher energy $\pi$ orbital is the $\pi^*$ anti-bonding orbital (analogous to the $\sigma^*$ anti-bonding orbital). If the energy of the $2p_y$ orbitals is $\alpha$, the Hückel approximation predicts that the $\pi$ bonding orbital is lower in energy by a value called $\beta$ and $\pi^*$ is higher in energy by $-\beta$. Since $\beta$ turns out to be negative ($\beta = -75$ kJ/ mol), the energy of the $\pi$ orbital is $\alpha + \beta$ and that of $\pi^*$ is $\alpha - \beta$.

Since each $2p_y$ orbital is occupied by one electron, on forming the $\pi$ bonds, both electrons now occupy the $\pi$ bonding molecular orbital (with opposite spins). Hence, the energy of each electron occupying the $\pi$ bonding orbital is lowered by a value of $\beta$ relative to the $2p_y$ orbitals. So on forming the $\pi$ bonds the total energy of the ethylene molecule is lowered by $2\beta$ ($\beta + \beta$, for each $\pi$ electron) relative to the energy of the ethylene molecule with two $2p_y$ atomic orbitals. Hence, forming the $\pi$ bonds makes the ethylene molecule more stable.

We can pictorially represent these two molecular orbitals as follows (Figure 6):

![Image of π bonding orbital and π* anti-bonding orbital](image)

Figure 6

From the figure of the $\pi$ bonding orbital, you can immediately see that the effect of forming the $\pi$ bonding molecular orbital is that the electrons, originally in each of the $2p_y$ atomic orbitals located over single carbon atoms, are now spread out or “delocalized” in a molecular orbital over two carbon atoms. This delocalization of the position of the electrons results in lowering the energy of the $\pi$ bonding orbital relative to the $2p_y$ atomic orbitals.

Let’s now look at the $\pi$ molecular orbitals of a slightly larger molecule 1,3-butadiene (Figure 7)
Similar to ethylene, each of the carbon atoms has a $2p_y$ atomic orbital, lying perpendicular to the $\sigma$ bond framework (all C-C and C-H $\sigma$ bonds), with an electron in each of these atomic orbitals. These four $2p_y$ orbitals can overlap to form $\pi$ bonds. Once again, using the Hückel approximation we can determine the energies and shapes of these $\pi$ molecular orbitals. As we can see in Figure 8, combining these four $2p_y$ atomic orbitals, we end up with four $\pi$ molecular orbitals.

Once again, we will reference the energies of these orbitals with respect to $\alpha$, the energy of the $2p_y$ atomic orbitals. We see that two $\pi$ molecular orbitals lie below $\alpha$ (these are the $\pi$ bonding orbitals located $-1.618\beta$ and $-0.618\beta$ below $\alpha$) and two lie above $\alpha$ (these are the $\pi^*$ anti-bonding orbitals located $1.618\beta$ and $0.618\beta$ above $\alpha$). The four electrons from each of the $2p_y$ orbitals occupy the lowest two $\pi$ bonding orbitals, in pairs and with opposite spin.

Since the four $\pi$ electrons occupy molecular orbitals at energies lower than the $2p_y$ atomic orbitals, we expect that formation of the $\pi$ bonds lowers the energy of the butadiene molecule. In fact, it lowers the energy by $2(1.618\beta) + 2(0.618\beta) = 4.472\beta$ (each electron occupying the lowest $\pi$ orbital has an energy $1.618\beta$ lower than $\alpha$ and each electron in the next
\( \pi \) orbital has an energy \( 0.618\beta \) lower than \( \alpha \). So once again forming \( \pi \) bonds lowers the energy of the molecule. As with ethylene, the energy of the molecule is lowered since the \( \pi \) electrons are now delocalized over the entire butadiene molecule instead of being localized in a 2py atomic orbital. Figure 9 shows the shape of just the lowest \( \pi \) bonding molecular orbital with energy \( \alpha + 1.618\beta \).

\[ \text{Figure 9} \]

**Effect of the length of the conjugated molecule on delocalization.**

As we saw above, the butadiene molecule is more stable by \( 4.472\beta \) with respect to the energies of four 2py atomic orbital. Let’s compare this energy with the sum of the energies of two isolated ethylene molecules (once again relative to the energies of four 2py atomic orbitals). Each ethylene molecule is stabilized by \( 2\beta \) (relative to the energies of four 2py atomic orbitals). So two isolated ethylene molecules are stabilized by a value of \( 4\beta \) (relative to the energies of four 2py atomic orbitals). Comparing the stabilization energy of two ethylene molecules due to \( \pi \) bonding (\( 4\beta \)) to that of one butadiene molecule (\( 4.472\beta \)), we find that the butadiene molecule is more stable by \( 0.472\beta \). Why is this so? This extra stabilization in the butadiene molecule is once again due to **delocalization** of the \( \pi \) electrons over the length of the molecule. In general, the longer the length of the conjugated molecule, the larger is the degree of stabilization due to **delocalization**.

Use the Hückel program to calculate the energies of the \( \pi \) orbitals in ethylene and 1,3 butadiene.

You will now use a program called “Hückel” to calculate the energies of the \( \pi \) orbitals and determine the shapes of the \( \pi \) molecular orbitals in ethylene.
Open the Hückel program.

At the top of the window is a menu with the following options - File, Edit, View, Calculation, Help.

Below the menu is a tool bar.

Below the tool bar is a page with a grid.

**Tool Bar**

First focus on the tool bar. The first entry in the tool bar is a dialog box with the word “Carbon”. Next to “Carbon” is a scroll window with a down arrow. Hold the mouse down on the arrow. You will see the following options - “Fluorine”, “Oxygen”, and “Nitrogen”. For now keep the selection on Carbon.

This is followed by an icon that allows you to draw atoms, an icon for single bonds, an icon for double bonds, and then an icon with a red cross. If you place your cursor over any of these items in the tool bar, after a second, a short description of the icon will appear below the icon. You can use this message box as a way of identifying icons.

The first thing to do is draw a molecule on the page with the grid. Let’s start by drawing an ethylene molecule. With Carbon selected, select the first icon (for drawing atoms). Click on one of the dots on the grid. You will see C1 appear marking the first carbon atom. On the next grid point, click again and C2 appears. Since we are building ethylene, choose the double bond icon. Click on C1 and, holding the mouse down, drag to C2. You should see a double line connecting C1 and C2. This is the double bond in ethylene. In this program you do not have to worry about the H atoms since the Hückel approximation models just the $\pi$ bonds. If at any time you need to erase a part of the molecule click on the icon with the red cross. This is the “erase” icon. Having selected this icon, click on the part of the molecule you would like to erase.

**Hückel Calculation**

(i) Ethylene

Now we will “submit” the ethylene molecule for a Hückel calculation. Under “Calculation” select “Build Hückel Matrix”. This does the first part of the calculation (which is completed almost instantaneously). Next go back to “Calculation” and select “Perform Hückel Analysis”.
This completes the Hückel calculation. (Note for larger molecules it may take longer to do the above two jobs.)

View Energy Level Diagram and Molecular Orbitals

Next, you want to view the energy level diagrams of ethylene. In the “View” menu item select “Eigenvalue” → “Level Diagram”. You should see an energy level diagram with two energy levels above and below a dotted line (similar to the one in Figure 5). The dotted line corresponds to $\alpha$, the energy of the 2p$_y$ atomic orbitals. The lower level is labeled with an energy of 1.00 and this corresponds to $\alpha + 1.00\beta$. The upper level is labeled with an energy of -1.00 and this corresponds to $\alpha - 1.00\beta$. The lower level is occupied by two electrons, denoted by two filled blue circles. (In this diagram the upper level is shown to be unoccupied with two unfilled circles. These two unfilled circles denote two “holes” which signify the lack of electrons). At the right of the diagram each level is labeled with (1). This number refers to the number of energy levels at the same energy (called degeneracy). In the case of ethylene, there is one energy level at each position denoted. (Some of the examples you will look at later will have more than one energy level at the same energy). So, for ethylene, we can see two energy levels at $\alpha + 1.00\beta$ and $\alpha - 1.00\beta$. The lower energy level is occupied by two electrons.

Next, we want to look at the molecular orbitals. To do this, first close the energy level diagram. Go to the “Option” menu and select “Close”. This closes the energy level diagram. Now go to the “View” menu and select “Eigenvectors” → “MO diagram”.

You will see the shape of the lowest energy molecular orbital (MO1). This will look different than the one in Figure 6 but conveys the same information. Note that each carbon atom is denoted by a filled blue circle of the SAME diameter. How do we interpret this figure? A molecular orbital is formed by linear combinations of atomic orbitals. In the case of the $\pi$ bond system in ethylene, the $\pi$ bond is formed by combining two 2p$_y$ atomic orbitals. In the MO diagrams generated by the Hückel program, you will see filled blue circles or open circles around each carbon atom. The diameter of the circles represents the relative contributions of each atomic orbital to the resulting molecular orbital. The coloring of the circle (filled vs. open) represents the sign of the contribution (positive or negative), where the sign of the contribution affects the shape of the resulting molecular orbital.
Looking at the lowest energy molecular orbital of ethylene (MO1 in the Huckel program) note that each carbon atom is denoted by a filled blue circle of the SAME diameter. The equal diameter denotes that each atomic orbital contributes equally to the molecular orbital. Since the sign of the contributions from both the atomic orbitals are the same (in this case both are positive), the two atomic orbitals combine “in phase” resulting in a \( \pi \) bonding orbital (with no node between the two carbon nuclei). The resulting \( \pi \) bonding orbital is delocalized over both carbon atoms. You can also see the energy of MO1 (1.00) at the top of the page along with the occupation of this level (2 electrons).

Now look at the highest energy molecular orbital (MO2). This time one carbon atom is represented by a filled blue circle and the other an open circle of the same diameter. The fact that the diameters are the same indicate that the contribution of each 2py atomic orbital to the molecular orbital is equal. However, since their signs are opposite, the two 2py atomic orbitals combine “out of phase” resulting in a \( \pi^* \) anti-bonding orbital (with a node between the two carbon nuclei) of higher energy than the 2py atomic orbitals.

Save File
Save the ethylene molecule file to your floppy disk (“File” → “Save As”)

(ii) Butadiene
Select the atom drawing icon. Click four horizontal dots on the grid (should be labeled C1, C2, C3, C4). Then select the double line icon. Connect C1 and C2 with a double line and C3 and C4 with a double line. Next select the single line icon. Connect C2 and C3. Do a Hückel calculation and look at the energy level diagram (should be similar to Figure 8). Sketch the energy level diagram. Look at the molecular orbitals. Sketch the molecular orbitals as shown. Comment on MO1. Given the size of the circles, note that MO1 is delocalized over the entire molecule, but with a larger concentration over C2 and C3 than C1 and C4. Compare the energy of the butadiene molecule with two isolated ethylene molecules. Save the butadiene file to your floppy disk.

Exercise
Use the Hückel program to answer the questions below.
1) Perform a Hückel calculation for cyclobutadiene (structure shown below).
Note: for the cyclobutadiene molecule you have to construct a square with the carbons. Use the grid points as a guide.)

Using the results of your Huckel calculations for 1,3-butadiene (which you did earlier) and the cyclobutadiene (which you just completed), compare the energy level diagrams of cyclobutadiene and 1,3-butadiene and the shapes of the lowest energy molecular orbital. Sketch the energy level diagram and the shape of the lowest energy molecular orbital. Comment on any differences and similarities between the energy level diagrams and the shape of the lowest energy molecular orbital. Which molecule is more stable and by how much?

2) Repeat exercise 1 with the following molecules, commenting on any differences and similarities between the energy level diagrams and the shape of the lowest energy molecular orbital.

1,3,5 hexatriene vs. benzene (structures shown below).

(Note: For the 1,3,5 hexatriene molecule, you can construct a straight chain. You do not have to draw the molecule with the “zigzag” shape as shown. For the benzene molecule, you have to construct the hexagon (with the double bonds). Use the grid points to help draw the hexagon).

Which molecule is more stable and by how much?

3) Construct a conjugated chain with 12 and 24 and 48 carbon atoms (use the scroll arrows at the bottom of the window to increase the size of the grid page). Comment on how the spacing between energy levels is affected by chain length.
4) Predict what the energy level diagram would look like for an infinitely long conjugated chain.